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Although I have been an astrophotographer for many years, I didn’t take the digital 

plunge until June of 2006.  Still using film, I believed that digital imaging technology 

was leaving me behind.  Besides, good film was getting harder to find!  I found that the 

learning curve is very steep with digital imaging, but eventually with some persistence, 

learned how to use Nebulosity capture and processing software and PHD Autoguiding 

programs that were created by Craig Stark of Stark-Labs.  By joining many astronomy 

Yahoo groups and driving a lot of people crazy, I became somewhat of an expert in a 

short period of time.  Nebulosity has a lot of bells and whistles that I don’t pretend to 

understand, but as time goes on, I hope to learn more and more of Stark-Labs software 

programs.  Thanks to the work of Kip Pauls, John Armstrong, Michael Covington, Ed 

Hall, Michael Garvin, and Craig Stark and many others for their support. 
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Note:  If the guide camera has a self contained ST4 guider such as the Q-Guider or SBIG 

cameras, the GPUSB interface is not used and the RJ-12 cable would run directly from 

the guide camera to the mount.  Tip:  Color-code your USB hub with the USB cables.  

This color coding will help immensely when setting up. 
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Before starting, it is highly recommended that you turn off any screen savers and adjust 

the settings for your laptop so that it will not shut itself off for the lack of activity.  Many 

times, you’ll spend hours imaging without touching the laptop.  In fact many “old pros” 

go to bed while the laptop does all the work.  I also recommend that you turn off the WI-

FI or internet connection.  The laptop works its magic best when it is devoted strictly to 

imaging and autoguiding.  As a precaution, you may want to consider using deep cycle 

batteries and inverters for your power source in case you live in an area with frequent 

power outages.  Once there is a power glitch, you’ll have to reboot everything and start 

over and that may be hard to do after you’ve gone to bed. 

 

Although the Canon battery (NB-2LH) is very reliable, it will not be suitable for long 

exposure photography especially with exposures of 5-15 minutes per frame and in cold 

temperatures.  I highly recommend that the ACK-DC20 power supply be used.  The 

Canon EOS series camera will not operate properly below freezing.  I recommend that 

you wrap a dew heater around the camera in cold climates 

 

Before starting, check your camera settings.  I have had many nights go bad because I 

forgot to preset the camera correctly. Nebulosity controls the camera, but there are few 

things you must do first.  Set the Canon EOS to “M” manual.  Turn on the camera and 

turn the wheel just behind the shutter button until the LCD readout reads, “bulb.”  Press 

the “menu” button and go to “Tools 2” and scroll down to “Custom Functions.”  Go to 

#2, “Long Exposure Noise Reduction.”  If you want the camera to automatically dark 

subtract as each frame is taken, set it to “ON.”  I do not recommend this as it will take 

twice as long to take an image and you may not need to dark subtract so set it to “OFF.”  

You can dark subtract manually during processing.  While in the menu, go to 

“Communications” and select “PC Connection.”  Set the Auto off control to “OFF” 

otherwise the camera will turn itself off after a few minutes leaving you scratching you’re 

the next morning why it didn’t take any photos.  Don’t worry about the ISO setting or the 

size of the image as these will be controlled in Nebulosity. 

 

Important USB cable information.  Some laptops only have a couple of USB ports that 

only provide 5VDC @ 500mA.  That’s not enough to power all the devices.  I highly 

recommend that you purchase a multi-port “powered” USB hub.  My hub is 7-port, 

5VDC @ 3 amps which is more than enough power. 

 

Is everything connected according the wiring diagram above?  Are the cameras mounted 

using T-rings and T-adapters to prevent differential flexure of the two telescopes and 

their camera attachments?  Don’t worry about how the guide camera is mounted as PHD 

is not orthogonal (oriented north south etc.).  Avoid using nose pieces as the cameras may 

move slightly during a capture session.  Is the fork-mounted telescope wedge mounted 

and drift aligned? Alt/Az mounts are not suitable for astrophotography. If using a GEM, 

remember that you’ll have to do a “Meridian Flip” in the middle of your session if you 

plan an all night session starting in the east. OK then turn the power on and boot-up the 

laptop. This is a good time to focus the Canon by looking through the camera’s 

viewfinder.  That will give you a rough focus. Fine focus will come later. 
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All things must be done in sequence.  Be sure no other programs are running and be sure 

that you have a relatively bright star in the center of your guide scope (use an eyepiece 

extended all the way out) then replace the eyepiece with the guide camera.  The laptop 

must be devoted ONLY to imaging and autoguiding.  Open PHD.  Click the first button 

on the left which is the camera icon and select your guide camera.  Next, click the 

telescope button.  Click on the “Mount” tab at the top and select GPUSB or if you have a 

self guiding camera such as the Q-Guider, select “On Camera.”  Click the next button 

which is the “Loop.”  Default is .2 seconds.  You can change it to longer exposures by 

clicking the “Stop” button and clicking on the drop-down menu for the time.  It can be 

adjust from .05 to 10 seconds.  Don’t be surprised if you can’t see anything on the PHD 

screen.  It is likely that it is out of focus or you’ve forgotten to take the lens cap off.  

Focus until you get a good round star.  If it won’t focus, you may have to extend the T-

adapter or as a last resort, use a diagonal.  Once you think it is focused, click the stop 

button.  Now find a dim star and click on it.  Click the “Target” button.  That will start 

the calibration process.  The star will go one direct, stop, come back and start the DEC 

calibration.  Look in the lower left hand corner and it will tell what it is doing.  If the 

calibration fails, it means that the telescope and PHD are not communicating.  Check 

your cables for the proper connections.  Remember that the RJ-12 cable must be plugged 

into the “Autoguider” port at the base of your mount and not into the hand control.  Once 

it has completed the calibration, it will say, “Guiding.”  Now “Minimize” PHD (don’t 

worry, it will autoguide while minimized). 

 

Here are my PHD settings located within the brain icon: 

RA Aggressiveness: 85 

RA Hysteresis: 10 

Dec Guide Mode:  Auto 

Dec Algorithm: Resist switching 

Calibration step (ms): 2000 

Min. Motion (pixels): 0.25 

Search region (pixels): 15 

Time Lapse (%):0 

Force Calibration:  (If you want to recalibrate for each target in one evening, check the 

box otherwise leave it unchecked)  Once the autoguider is working and calibrated, one 

need not recalibrate each time. 

 

Note:  If you will be using a Celestron NexStar or CPC series telescope, you may find 

these settings useful: 

Autoguide Rate: 40% 

AZ Backlash: 0% 

DEC Backlash:  20-30 
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Capturing Images 

 
Turn on the Canon EOS camera.  You should see a double flash of red light in back of the 

camera indicating that it has power and is on.  Wait a few seconds for Canon Utilities 

program to appear on the screen.  Click “Quit.”  Nebulosity and Canon Utilities do not 

like each other and you will soon have an error message.  After closing the Canon 

Utilities program, open Nebulosity.  Click the “File” tab at the upper left hand corner.  

Near the bottom of the list, click “Preferences.”  Click “Acquisition Mode” and select 

“RAW Acquisition.”  Next, click “DSLR Long Exposure Adapter” and select 

“Shoestring DSUSB.”  If this option is not selected, the camera will only give you 30-

second exposures max.  Leave all the other settings alone unless you know what you are 

doing.  The only other setting would be to check the “use the msec not seconds” box if 

you want extremely short millisecond exposures say of the sun.  At the bottom, click the 

“Done/Save” button.  Your preferences will stay that way until you decide to change it. 

 

Warning!  If you do not make the necessary selection in the “Preferences” section to 

“RAW Acquisition,” the Canon EOS camera will capture images in JPG color 

format instead of FITS.  Processing these images may be impossible as each frame 

will be an incredible 45.5 MB. 

 

Now look on the right side of the screen under, “Camera” heading, click the down arrow 

for the drop-down menu.  Select “Canon DIGIC II DSLR.” (DIG!C by the way, is a 

Canon high speed digital processor which is an acronym for Digital Integrated Circuitry 

and yes, the exclamation point trademark is the correct way to spell it.   DIG!C II 

processors are found on the EOS 350D, 400D, 20D, 20Da and 5D).  Allow the camera 

and Nebulosity to shake hands.  In the lower left hand corner, it will tell you which 

camera you have connected.  If the cable connection is bad or you forgot to connect the 

USB cable to the camera or computer, you’ll get an error message.  Note that DIG!C III 

processor cameras that are found in PowerShot series and the new 40D may not work 

with Nebulosity, but Craig may be looking at changing this in the future. 

 

Bring up PHD again.  Click the “Stop” button and minimize.  Turn your telescope to a 

relatively dim star near the target.  (Always stop PHD autoguiding before slewing the 

telescope)  Please don’t try to focus on Sirius, Venus or other bright object.  You are now 

going to fine focus the Canon, but you’ll need a star at about a magnitude 7 or dimmer.  

It’s not like focusing the camera for a snapshot with AutoFocus (AF).  Focusing a digital 

camera is a bit different than the old film snapshots.  The CMOS chip in the DSLR is 

much more sensitive to light than your eye.  We want the dim star to use as few pixels as 

possible.  This will take some time and practice, but you will be rewarded with 

exceptionally sharp digital images.  Craig Stark has made focusing very easy in 

Nebulosity.  The pixel algorithm does all the work for you.  All you need is time and 

patience. 

 

Select 1-second time exposure on the right side of Nebulosity.  Now click “Frame and 

Focus.”  If you see “Dancing Stars,” you are looking at hot pixels.  Remove the lens 

cover! The center of the crosshair will be off to the right.  This is the default picture.  Go 
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up to the top under the histogram and click the minus sign to zoom out.  I like to use 25 

or 33 power for Frame and Focus.  The image on the screen will refresh every one 

second.  Center your object on the crosshair.  Now enlarge PHD and click the “Loop” 

button.  Find a star and click on it.  Click the “Target” icon and it should start autoguiding 

immediately.  This will hold the telescope on that star until you’re finished focusing. 

Now minimize PHD and go back to Nebulosity.  Once you have it centered, don’t move 

the telescope as the autoguider is working.  If you move it and the autoguider looses its 

guide star, you’ll hear an audible beep.  In Nebulosity, click “Abort” and that will stop 

the “Frame and Focus.”  Now click “Fine Focus.”  In the lower left hand corner, it will 

tell you to “Click on a star.”  Click on a very dim star for fine focus.  The fine focus 

screen will now appear in the upper left hand corner of the screen.  You can use the zoom 

in and out buttons under the histogram to see your focusing star better.  You will also see 

a graph and a graphical representation of the pixels of the star.  You’ll see the letter “M”, 

“m” and “S”.  “M” is for the maximum pixels level, “m” is the average pixel level of 

three frames and “S” is Sharpness.  Adjust the focus on your telescope until you can get 

the highest “M” level possible (65,535 is the highest it will go.  If you have that kind of 

level.  Abort and click fine focus again, but pick a dimmer star or shorten your exposure).  

Also watch the graphical cone.  As you increase the pixel level and thus becoming 

sharper, you’ll notice the cone will become increasingly narrow.  When focusing, make 

your corrections very small.  Use a micro-focuser if your have one and make very minor 

adjustments until you have the highest possible number.  Don’t worry about the camera 

shutter working overtime.  Canon shutters are designed for 100,000 actions.  Once you 

are satisfied and have tighten down the focus, click “Abort” and that will stop the fine 

focus. 

 

To start imaging, I recommend that beginners select large objects such globular clusters 

or large galaxies.  Often, beginners start by trying to image faint DSOs such as the 

Rosette or the Veil Nebula.  Before slewing the telescope, be sure to stop the 

autoguider in PHD.  Select your target and slew there.  Select frame and focus, zooming 

out to 50 or 33.  Center your object then click “Abort.”  

 

Now it’s time to start Autoguiding again.  Enlarge PHD from the bottom of the screen.  

Click on the “Loop” button to see some stars.  If the stars are too dim, change the 

exposure time to 1 second.  Remember that you have already calibrated PHD.  Click the 

“Stop” button and immediately click on a star.  A box will appear around it.  Now click 

the “Target” button and it should start guiding instantly.  Now minimize PHD. 

 

In Nebulosity, experiment with exposure times by clicking  “Preview” until you see a 

nice histogram.  A good histogram should have a lot of red on the left and gradually 

diminishing off to the right.  If all of the pixel light is bunched up on the left, the 

exposure is not long enough.  Once you are happy with the histogram, click “Abort.” 

 

You’re almost ready to capture your object, but first you must give the object a name and 

a folder for storage.  Below the “Abort” button, is the name of your object.  Delete the 

“series1” and insert the name of your object such as M13.  Next, click “Directory.”  Click 

on My Documents and then “Make Folder.”  Name the folder M13.  Click “OK.”  We’re 
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almost ready.  Check to see that you have the correct exposure time.  Enlarge PHD and 

double check to see if we are still autoguiding.  If it’s still guiding, minimize it.  Now 

insert the number of exposures.  For beginners, I recommend 30 exposures.  Now click 

“Capture Series.”  The computer will do the rest.  Time to go for a cup of coffee or you 

can watch as each FIT frame is stored.  A word about windy conditions.  Although PHD 

will do its best to autoguide, wind can shake the scope and ruin your image.  You’ll see 

star movement on each frame.  Best to call it a night and try again on a windless night. 

After you’ve done a few of these images, with a long 300-second exposure requiring the 

whole night or a series of nights, you’ll be able to go to bed and not worry about until you 

get up in the morning.  

 

Gain – ISO setting.  ISO is like the old ASA settings in film.  The higher the ISO, the 

more sensitive the chip and the more noise is introduced.  We can control this noise with 

the use of dark frames and flats discussed later.  I like the default level of 4, ISO 1600 

because exposure times will be shorter and the camera will detect very faint objects. 

 

Offset:  Leave the setting alone.  I believe it is grayed-out when using the Canon.  The 

gain is automatically set by Nebulosity. 

 

By the way, you can open both PHD and Nebulosity windows at the same time.  You can 

slide the PHD window over to one side to see the capturing process while watching the 

guide star in the crosshair. 

 

Taking Dark Frames:  The CCD chip in CCD cameras such as the Orion StarShoot, 

Meade DSI and others and the CMOS chip used in the Canon EOS series have inherent 

random electronic noise.  The less the noise, the more expensive the CCD chip.  To 

eliminate as much noise as possible, we need to take some dark frames that we will 

combine with the light frames later during processing.  You can take these dark frames 

before or after your imaging session.  The footprints must match.  The dark frames must 

have the same amount of exposure time and temperature as the light frames.  They must 

also have the same ISO setting.  If you took thirty 60-second light frames of M13 at ISO 

1600 at 50 degrees outside, then your dark frames must be 60-seconds at ISO 1600 at 50 

degrees.  You need only take 10 dark frames.  To take a dark frame, simply cover the lens 

with its dust cover, change the name to “M13Dark” and click “Capture Series.” 

 

Congratulations.  Now that you have all the data need to produce a beautiful image of 

your object, it’s time to process them.  Don’t try to process them the same evening or 

morning.  You’ll be too fatigued.  Wait until the next day after you’ve had some sleep. 

 

A word about Murphy.  Murphy is alive and walking around your telescope and 

computer at night.  Taking digital images, besides spending a fortune on all the gadgets 

needed, requires a lot of mental exercise.  Don’t even attempt an imaging session unless 

you’re rested.  This is a complex system and requires constant vigilance.  Any number of 

things can go wrong.  Cables can become twisted, settings are wrong, forgotten focal 

reducers, dust caps left on, coffee spilled on the laptop and plugs being accidentally 

pulled.  Many give up because astro-imaging is a lot of “WORK.”  To get excellent 
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images, the hardest part is yet to come…the processing.  Since each frame taken by a 

Canon EOS series camera is a staggering 15.3 MB it requires hours of tedious work. 

Don’t get discouraged.  In time, all of this will become second nature and your astro-

library will be filled with amazing deep space images.  I like to make prints of my best 

work, frame them and hang them in the observatory or garage.  I even have a few in my 

den. 

 

 

Processing Images 
 

Now that you’ve done the easy part…capturing images with your Canon EOS series 

camera and…you have had a good night’s sleep, it is time to do the hard 

part…processing your RAW images into a gorgeous piece of art.  Let’s start out with 

some warnings.  If your laptop doesn’t have a fast processor or at least 1 GB of RAM, 

don’t even think about processing your images on a laptop.  It will take hours and 

perhaps a couple of days before they’re finished.  Canon cameras are memory hogs.  

Remember, each frame will be an incredible 15.3 MB compared to say a Meade DSI 

CCD camera where each frame is only 15 KB. .  If you’ve taken a lot of frames, do the 

math.  I suggest that you buy a 2 GB flash drive and transfer all your frames into a more 

powerful desk-top tower computer that has a lot of processing power.  You should have a 

nice astro-photo in a couple of hours. 

 

Make sure that you have the same version Nebulosity in both computers.  Open 

Nebulosity on your desk-top.  The first thing that we must do is stack all your dark 

frames. We’re going to stack all the dark frames that you took last night and combine 

them to make a MasterDark frame.  At the top of the screen, find the “Processing” menu 

and click it.  Select “Align and Combine Images.”  An “Alignment/Stacking” window 

will open.  Click the “Save Stack” button;  click “None (fixed); click “OK.”  A new 

“Select Frames to Combine” window will open.  At the very top of this window, click the 

drop-down menu and find the folder where all your frames were transferred from the 

laptop.  It should be in the M13 folder.  Click the folder and you’ll find all the frames that 

you took.  Click the first “M13Dark” frame and then go to the last dark frame and while 

holding down the shift key, left click the mouse.  All of the “M13Dark” frames will be 

highlighted.  Click “OK” and Nebulosity will automatically stack all your dark frames.  

When it is finished, you will see a “Save Image” window.  Click the drop down menu at 

the top and be sure you have the M13 folder, then give the stacked dark frames a name.  

For example, I use “M13DarkMaster.”  Click the “Save” button.  Congratulations!  You 

have just finished the first step in processing your piece of art. 

 

The next step is to subtract the M13DarkMaster frame from all of your light frames in 

order to reduce the pixel noise of the camera’s chip.  Again, using the “Processing” 

menu, select “Preprocess B&W/RAW Images.”  At this time, don’t be concerned about 

Bias, Flat or Autoscale Dark.  Click the “Dark” button and select your “M13DarkMaster” 

frame.  Now click “OK.” A new window will appear and ask you to select your light 

frames.  As before, click the first light frame image (in this case it will be 

“M13_001.FIT”) and then go the very last frame and “Shift + left click” and all the light 
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frames will be highlighted.  Click “Open.”  Nebulosity will now automatically subtract 

the Dark Master frame from all the light frames.  These new frames will automatically be 

saved in the folder as PPROC.  This may take a few minutes, depending on how many 

frames you took so this may be a good time to walk the dog. 

 

When Nebulosity has completed the dark-subtract processing, it will tell you in the lower 

left corner of the screen.  Since the Canon is a color camera, you no doubt want to have 

your image in color.  This next step adds the color and squares the pixels.  Again, click 

the “Processing” menu and select “Batch Demosaic + Square RAW Color.”  Next, as 

before, select the first PPROC frame and then “Shift + left click” the last frame, then 

click “Open.”  As each frame is processed, Nebulosity will label them as “RECON.”  

Again, this will take some number crunching and watching it will be as exciting as 

watching an apple turn brown.  The left bottom of the screen will tell you when this 

process is finished.  It’s time to take another break. 

 

Now we are ready for the exciting part; combining or stacking all the preprocessed light 

frames.  From the “Processing” menu, select “Align and Combine Images.”  Again, the 

“Alignment/Stacking” window will open. 

 

A little side-bar here before proceeding: 

 

“Translation” means that Nebulosity will stack your selected star up, down, left or right.  

Neither telescope mount nor autoguider is perfect.  Stars will move ever so slightly from 

one frame to another and this is perfectly normal.  This “Translation” will follow the 

movement of your chosen star. 

 

“Translation + Rotation” means that Nebulosity will align and stack not only the one 

star, but two stars to prevent field rotation. Even the best drift aligned, wedge mounted 

scope may have some rotation. This is my favorite option and I always use it because 

there is some very minor rotating regardless of how well you have your telescope drift 

aligned.  If you keep your exposures short, you can use this option to stack images taken 

from an Alt/Az mount. 

 

“Translation + Rotation + Scaling” means that if you have taken several images over a 

period of several night using different telescopes, Nebulosity will compute the 

differences.  This option is rarely used, but might be appropriate if the image size 

changes when you touch-up the focus. 

 

Ok now back to what I saying.  Be sure to click the “Save Stack” button at the top.  Select 

your method of stacking.  Select ”Translation + Rotation.”  Be sure the “Adaptive scale 

stack to 16 bits” box is checked.  Click the “OK” button.  A new window will appear.  

Click all the “RECON” frames, then click “Open.”  Allow a few seconds for the program 

to gather all the RECON frames.  You should now see a small cross that replaced the 

cursor.  Zoom in…or out to 100.  Align the slider bars on the right and bottom of the 

image until your object is centered on the screen.  With the mouse, select a small 

unassuming star on the left of the image.  Before left clicking this star,  look around the 
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rest of screen to be sure that this frame is a keeper.  Any airplanes, satellites, or moving 

stars?  If not and the frame looks good, click the star.  A red circle will now be placed on 

the star and the cursor again changes to a cross. Don’t try to be perfect, Nebulosity will 

find the center of the star for you.  If the frame had star movement or something that 

wasn’t supposed to be there, you can reject the frame by pressing the “Shift key and left 

clicking” anywhere on the screen.  Continue to click your red marked star on the rest of 

the frames as they come up. When it has finished with all the frames that you selected, 

there will be a cross in the middle of the red circle.  Now move the slider at the bottom of 

the screen and find an unassuming star on the right of your object and click on it.  Again, 

you can reject any image for whatever reason.  This time, there will be a green circle 

around the second star.  Continue clicking until the all the frames are finished.  When 

completely finished selecting your stars for stacking, Nebulosity will crunch more 

numbers until it is finished.  This will take a few minutes so it’s time for another break.  

When finished, type in the name of your stacked image.  I like to use the object’s name + 

stacked such as in this case “M13Stacked.” 

 

Next, find the “Image” menu and select “Adjust Color Background (offset).”  When the 

“Adjust Color” screen appears, don’t adjust anything.  Simply click “Done.” 

 

So far, your beautiful piece of art doesn’t look very good.  Don’t be discouraged as all 

good things will come.  The next step will be the WOW step.  Again, click the “Image” 

menu and select “Digital Development (DDP).”  Wait several minutes.  A lot of number 

crunching is taking place so be patient.  Our goal is to produce an image worthy of post 

processing in PhotoShop CS3 or similar program.  At this point, your image has two 

problems: 

 

1. The midtones are too dark relative to the rest of the image; that is, the image 

needs gamma correction. 

2. Depending on whether they were stretch earlier, the pixel values may not use 

the full range (0 to 65,535) of a 16-bit TIFF image. 

 

A quick way to address both of these problems is called Digital Development or DDP.  

This is a combination of gamma correction and unsharp masking (sharpening).  Digital 

Development was invented by Kunihiko Okano.  It is a rather quick algorithm to do what 

would otherwise be a multi-step process.  In Nebulosity, the DDP algorithm usually 

works extremely well with DSLR images.  Just go to Digital Development (DDP) and let 

the algorithm do its magic.  The best results can be had by simply pressing “Done” when 

it’s finished.  Although the defaults are usually reasonable, you can further improve the 

image by experimenting with the sliders.  If you’ve totally messed-up your image, click 

“cancel” and try again.  You’ll notice that the image has come alive with deep details not 

seen before albeit a bit grainy (noisy), but we’ll take care of the noise later. 

 

The next step is to click the “Image” menu and select “Levels/Power Stretch.”  In the 

“Levels/Power Stretch” window, you’ll see three sliders.  The top slider is “B” for black.  

The next slider is “W” for white and the bottom slider is the “Power slider.”  Don’t ask 

why or how, but the following settings will bring out more detail.  Move the “W” slider 
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1/4 to 1/3 to the left.  Move the “Power” slider to the left until it equals about 80.  Now 

move the “B” slider to the right just above the histogram peak.  If you’ve done it right, 

the histogram in the upper right corner should have a gradual decline from left to right.  

Move the “Levels/Power Stretch” window out of the way so that you can clearly see your 

object.  Don’t be afraid to play with the sliders to get an image that you like.  

Congratulations!  You have just produced a masterpiece.  Now it’s time to post process. 

 

 

 

Under the “Image” menu, there are some “Bin/Blur and other tools to smoothen the 

noise, but I and many others prefer to simply save the image as a JPG and move to 

another post-processing software program such as PhotoShop CS3.  Click “File” menu 

and select “Save JPG file as displayed.”  Be sure you load it in the folder of your choice.  

Now it’s time to post process. I like to use Microsoft “Picture It!  There is also a freeware 

program called Noiseware Community Edition which is available here 

http://www.imagenomic.com/download.aspx 

 

This tutorial is copyrighted and may be reproduced for personal use only or by 

permission for other purposes.  If you have a comment or suggestion that you think 

should be added or deleted to this tutorial, please send me an email at 

wb9sat@frontiernet.net 

 

Clear skies, 

 

Arizona Dollar Bill Logan 

Director and Chief Astronomer 

Robert Burnham Jr. Memorial Observatory 

Eagar, Arizona, USA 

 

 
Arizona Dollar Bill with film cameras. 


